
	
 

iModela 
 

Trouble Shooting 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2 
 

Table	of	Contents	
Q1: Output was possible previously, but suddenly the machine does not operate or output stops 

during cutting. What could be the cause? .............................................................................................. 3 

Q2: The driver cannot be correctly installed. ......................................................................................... 4 

Q3: The machine output is occasionally different from the data. .......................................................... 8 

Q4: The bundled software cannot be started. How can this be resolved? ............................................ 9 

Q5: The start point and end point of cutting are not aligned. ................................................................ 9 

Q6: The cutting‐in amount differs depending on the location. .............................................................. 9 

Q7: When the front and back are cut, they become misaligned. ......................................................... 10 

Q8: Is there a way to make the material surface (Z0) setting more accurate? .................................... 10 

Q9: Acrylic is not cut cleanly. ................................................................................................................ 11 

Q10: The cutting results are not clean. ................................................................................................. 11 

Q11: What is the black soot attached to the spindle motor? ............................................................... 11 

Q12: The taper of the cutter contacts vertical wall of the workpiece and interferes with cutting. How 

can I deal with it? .................................................................................................................................. 11 

Q13: How can I remove the cutter from the collet? ............................................................................. 11 

Q14: What should I do when the cutter falls off the collet? ................................................................ 12 

 

	

	

	

	
 

 

 

 

 



3 
 

Q1:	Output	was	possible	previously,	but	suddenly	the	machine	does	
not	operate	or	output	stops	during	cutting.	What	could	be	the	cause?	

A: Any of the following could be the cause when these problems occur with outputting. 

Verify each condition in the order that they are listed below, and correct them as necessary. 

1. Connection issues  

Since the primary cause for not being able to output may be a faulty connection, first check that the cables have 

not been disconnected and are fully and firmly plugged in. If the machine has not been used for a long period of 

time, the connector contacts may become corroded, resulting in poor data transmission, making the reception 

unreliable. In that case, the issue may be resolved by unplugging the connector and cleaning the contacts. 

Additionally, if a hub is connected between the PC and iModela, remove the hub and connect iModela directly to 

the PC. 

2. Memory or hard disk space issues 

If the data is different than the usual file data, or if a complex file, or large cut area is output, the memory or hard 

disk space may be insufficient and could prevent operation. To resolve this issue, check the PC's memory and 

hard disk space for the following: 

1) Memory issues 

If there is a large processing load, for example, due to the software being used to create the data or from the tool 

path being generated, the memory available for processing may be insufficient. 

 

◊ Try the following to resolve the issue. 

- If other applications are running, exit them since this can cause insufficient memory. 

- Restart the PC. 

- With complex shapes or large cutting areas, a large amount of memory is required. It may be necessary to add 

memory to the PC. 

2) Hard disk issues  

After tool paths are created in MODELA Player 4 CAM software, they are converted into the cutting operation 

language, which mills the design. Files can be very large when there are complex shapes. Before using this data 

to cut, there must be enough space available on the hard disk. 

◊ Try the following to resolve the issue. 

- Make sure that there is enough space available on the hard disk.  

- Be careful since the hard disk space is reduced when the data for cutting output files remains on the PC.  

- Delete unnecessary data from the PC. 

In addition, perform the following on-screen operation test to determine the cause of the issue. 
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Procedure: 

- Left-click the icon at the top of the iModela Controller window. 

- Click [Maintenance]. 

- Maintenance Window for iModela appears 

- Click the [Confirm] tab. 

- Click Idling [Start]. 

a) If the operation test can be performed with no problems, there may be memory or hard disk space issues.  

b) However, if the operation test could not be performed, continue to "3) Driver software issues" below. 

3) Driver software issues 

If points one and two fail to resolve the issue, then a problem with the driver software has occurred. 

In this case, re-installing the driver software as described below may revolve the issue. 

However, since all of the specified settings will be lost when the driver software is re-installed, make note of the 

necessary settings to save them for later use. 

Q2:	The	driver	cannot	be	correctly	installed.	

A: If installation stops before completion or if the wizard does not appear when the USB cable is used to connect 

the machine to the PC, follow the appropriate procedure described below. 

• Windows 7 

1. Use the USB cable to connect the machine to the computer. At this time, unplug the USB cable of any printer 

other than this machine. 
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2. Turn on the machine. 

3. If the Found New Hardware wizard appears, click [Cancel] to close it. 

4. On the taskbar, click [Start], and then right-click [Computer]. Click [Properties]. 

5. Click [Device Manager]. If the User Account Control dialog box appears, click [Continue]. 

The Device Manager window appears. 

6. Click [Show hidden devices] on the View menu. 

7. Double-click [Printers] or [Other devices] in the list. Click the model name or [Unknown device], whichever 

appears below the item that you selected. 

8. Click [Uninstall] on the Action menu. 

9. In the Confirm Device Uninstall dialog box, select the "Delete the driver software for this device." check box, 

and then click [OK]. Close the Device Manager window. 

10. Unplug the USB cable from the computer, and then restart Windows. 

11. Uninstall the Windows driver. 

12. On the taskbar, click [Start], [Control Panel], then [Uninstall a program]. 

13. Select the machine driver to be uninstalled, and then click [Uninstall]. 

14. When a message prompting you to confirm that you want to uninstall the driver appears, click [Yes]. 

15. We will now reinstall the driver. Download the latest version 

from http://download.rolanddg.jp/en/3d.html. Unzip the downloaded file on your local drive. 

16. On the taskbar, click [Start], [All Programs], [Accessories], [Run], then [Browse]. 

17. Select the name of the drive or folder where the driver is located. 

18. Select "SETUP.EXE", click [Open], and then click [OK]. 

19. If the User Account Control dialog box appears, click [Allow]. 

The driver installer starts. 

20. Click [Uninstall]. Select the machine that you want to uninstall, and then click [Start]. 

21. When a dialog box prompting you to restart the PC appears, click [Yes]. 

When the computer restarts, the uninstallation is finished. 

22. Follow the procedure in "Installing the Windows Driver" to install the driver again. 

• Windows Vista 

1. Use the USB cable to connect the machine to the computer. At this time, unplug the USB cable of any printer 

other than this machine. 

2. Turn on the machine. 

3. If the Found New Hardware wizard appears, click [Cancel] to close it. 

4. On the taskbar, click [Start], and then right-click [Computer]. Click [Properties]. 
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5. Click [Device Manager]. If the User Account Control dialog box appears, click [Continue]. 

The Device Manager window appears. 

6. Click [Show hidden devices] on the View menu. 

7. Double-click [Printers] or [Other devices] in the list. Click the model name or [Unknown device], whichever 

appears below the item that you selected. 

8. Click [Uninstall] on the Action menu. 

9. In the Confirm Device Uninstall dialog box, select the "Delete the driver software for this device." check box, 

and then click [OK]. Close the Device Manager window. 

10. Unplug the USB cable from the computer, and then restart Windows. 

11. Uninstall the Windows driver. 

12. We will now reinstall the driver. Download the latest version 

from http://download.rolanddg.jp/en/3d.html. Unzip the downloaded file on your local drive. 

13. On the taskbar, click [Start], then [Control Panel]. Click [Printer] under "Hardware and Sound". 

The Printers folder is opened. 

14. Click the name of the model that you are using. Click [Delete] on the Organize menu. 

If the User Account Control dialog box appears, click [Continue]. 

15. When a message prompting you to confirm that you want to uninstall the driver appears, click [Yes]. 

16. In the Printers folder, right-click any location where no printer icon is present. Select "Run as administrator", 

and then click [Server Properties]. If the User Account Control dialog box appears, click [Continue]. 

17. Click the Drivers tab, and then, in the "Installed printer drivers" list, select the machine that you want to delete. 

Click [Remove]. 

18. When the Remove Driver And Package dialog box appears, select "Remove driver and driver package", and 

then click [OK]. 

19. When a message prompting you to confirm that you want to uninstall the driver appears, click [Yes]. 

20. When the package and driver to be deleted are displayed, check that what is displayed is for the machine that 

you want to delete, and then click [Delete]. 

21. When the deleted items are displayed, click [OK]. 

22. Click [Close] in the Print Server Properties dialog box. 

23. On the taskbar, click [Start], [All Programs], [Accessories], [Run], then [Browse]. 

24. Select the name of the drive or folder where the driver is located. 

25. Select "SETUP.EXE", click [Open], and then click [OK]. 

26. If the User Account Control dialog box appears, click [Allow]. 

The driver's setup program starts. 

27. Click [Uninstall]. Select the machine that you want to uninstall, and then click [Start]. 
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28. When a dialog box prompting you to restart the PC appears, click [Yes]. 

When the computer restarts, the uninstallation is finished. 

29. Follow the procedure in "Installing the Windows Driver" to install the driver again. 

• Windows XP 

1. Use the USB cable to connect the machine to the computer. At this time, unplug the USB cable of any printer 

other than this machine. 

2. Turn on the machine. 

3. If the Found New Hardware Wizard appears, click [Finish] to close it. 

4. On the taskbar, click [Start], and then right-click [My Computer]. Click [Properties]. 

5. Click the Hardware tab, and then click [Device Manager]. 

The Device Manager window appears. 

6. Click [Show hidden devices] on the View menu. 

7. Double-click [Printers] or [Other devices] in the list. Click the model name or [Unknown device], whichever 

appears below the item that you selected. 

8. Click [Delete] on the Action menu. 

9. In the Confirm Device Removal dialog box, click [OK]. 

10. Close the Device Manager window, and then click [OK]. 

11. Unplug the USB cable from the computer, and then restart Windows. 

12. Uninstall the Windows driver. 

13. We will now reinstall the driver. Download the latest version 

from http://download.rolanddg.jp/en/3d.html. Unzip the downloaded file on your local drive. 

14. On the taskbar, click [Start], then [Control Panel]. Click [Printers and Other Hardware], and then open the 

Printers and Faxes folder. 

15. Click the name of the model that you are using, and then click [Delete] on the File menu. 

16. When a message prompting you to confirm that you want to uninstall the driver appears, click [Yes]. 

17. Click [Server Properties] on the File menu. 

18. Click the Drivers tab, and then, in the "Installed printer drivers" list, select the machine that you want to delete. 

19. Click [Remove]. When the confirmation message appears, click [Yes]. 

20. On the taskbar, click [Start], [Run], then [Browse]. 

21. In the "Look in" list, select the name of the drive or folder where the driver is located. 

22. Select "SETUP.EXE", click [Open], and then click [OK]. 

The driver's setup program starts. 

23. Click [Uninstall]. Select the machine that you want to uninstall, and then click [Start]. 
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24. When a dialog box prompting you to restart the PC appears, click [Yes]. 

When the computer restarts, the uninstallation is finished. 

25. Follow the procedure in "Installing the Windows Driver" to install the driver again. 

Q: This machine is not recognized. 

A: Check for the following. 

- Is anything caught on the spindle head or workpiece table? 

Is anything caught, impeding operation? If initialization is completed correctly after the machine is turned on, 

the power LED changes from flashing to on. If the power LED continues to flash, operations cannot be 

received. 

- Is the cable plugged in? 

Check that the cable is securely plugged in. 

- Was the machine started according to the correct procedure? 

Initialize the cutting machine, and then start the Control Panel. 

- Is a large amount of cutting waste present? 

Clean away any cutting waste. Clean the area around the spindle head especially carefully. 

- Is the driver installed correctly? 

If the machine is not recognized even after all items mentioned above have been checked, the driver may not 

be installed correctly. Re-install the driver. 

Q: I want to delete data from the driver's printer spooler on Windows XP, but the data is not removed even after 

Cancel (Delete) is selected. 

A: Try the following procedure. (Example for Windows XP) 

1. Go to [Control Panel]-[Administrative Tools]-[Services]-[Print Spooler], and then select "Stop". 

2. Delete the data at \WINDOWS\system32\spool\PRINTERS. 

3. Go to [Control Panel]-[Administrative Tools]-[Services]-[Print Spooler], and then select "Start". 

4. Restart the PC. 

Q3:	The	machine	output	is	occasionally	different	from	the	data.	

A: Any of the following may be the issue. 

- Software issues 

Upgrade the software (applications, Windows drivers, etc.) being used to a newer version. 

- Communication errors due to a poor or interrupted cable connection 

Try unplugging and plugging in the connectors, scraping the connector contacts, or replacing the cable with a 

new one. 
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- Communication errors due to interference 

These data errors can be due to electrical or radio interference. 

Malfunction may be caused by the cable being too long or radio interference picked up from a coiled cable. 

Try replacing the cable with a shorter one or separating it from the power cord. 

Check that there are no communication devices or motors producing radio interference nearby. 

- Unstable power supply 

Check if the malfunction only occurs while a device requiring a large amount of electricity is operating. 

- Cutting overload 

A malfunction may occur if the device is overloaded, for example, if the cutting-in amount is too large. 

- Machine malfunction 

There may be a faulty contact internally, or a malfunctioning circuit board. Check the connections. 

If an error is shown on the iModela Control Panel, read the cause and do the appropriate procedure. 

Q4:	The	bundled	software	cannot	be	started.	How	can	this	be	
resolved?	

A: Use Add or Remove Programs in the computer's Control Panel to delete the software, and then try installing it 

again. 

Q5:	The	start	point	and	end	point	of	cutting	are	not	aligned.	

A: Try the following. 

- Reduce the amount of extension of the tip of the cutter. 

- Change the cutting parameters (lower the cutting speed, reduce the Z cutting-in amount, etc.). 

- Clean or grease the drive system. 

- Allow the drive system to idle. 

- Check the data. 

etc. 

Q6:	The	cutting‐in	amount	differs	depending	on	the	location.	

A: Placing the disposable board on the workpiece table and surfacing it increases the accuracy. 

Affix a chemical wood board, for example, to the surface of the table, and then cut it with the straight end mill. 

Affix the material to be cut on top of this. Cut it in the same way. The height of the material will be uniform with 

the cutter, allowing stabilized cutting. 
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Q7:	When	the	front	and	back	are	cut,	they	become	misaligned.	

A: If the material shifts while being cut, try using more securing material or changing the method of securing the 

material (double-sided tape, instant glue, or creating a negative form to secure the material). 

Q8:	Is	there	a	way	to	make	the	material	surface	(Z0)	setting	more	
accurate?	

A: When a thin cutter is lowered, it is very difficult to recognize the moment that the tip contacts the material 

surface. 

If this is not set correctly, a large load may be applied, resulting in the cutter breaking. 

Try performing the following operations. 

- Recognizing the moment that the cutter tip contacts the material when the cutter is lowered 

After applying a fine powder to the material surface, painting it with white correction fluid or applying a spray that 

becomes powdery after it has dried, lower the cutter and stop when scattered powder is seen at the moment that 

the tip makes contact. 

Otherwise, place a sheet of paper on the material surface to recognize the contact point from the paper 

movement. 

Lower the tool with single clicks of the －Z key; do not hold down the key. 

*The setting must be specified with iModela Controller. 

- Surfacing to create a precise height 

Gradually grind down the high point in small amounts to create a precise material surface. 

Set the cut surface as the new material surface. 

With material that cannot be cut or material with a height difference on the surface, setting the low point as the 

material surface (Z0) may cause a large load in the higher areas when cutting is started. 

For accurate cutting, it is more effective to cut the material surface, even though this may seem tedious. 
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Q9:	Acrylic	is	not	cut	cleanly.	

A: Resins, such as acrylic, will easily melt if the rotating cutter comes in contact with the same location. 

Therefore, increase the X and Y speeds and reduce the Z cutting-in amount. 

In addition, if MODELA Player 4 CAM software is used, the cutting parameters for each material can be checked 

with [Customer Parameters] on the Options menu. 

If the cutter is blunt, the material will easily melt; therefore, be sure to use a new cutter. 

Q10:	The	cutting	results	are	not	clean.	

A: Check the following. 

- Are the cutting parameters optimal? 

The optimal cutting parameters are determined by the hardness of the material, the feed rate, the spindle 

revolution, the cutting-in amount and the capabilities of the tool. Adjust the parameters little by little while 

checking the cutting results. 

- Is the cutter firmly secured in place? 

Tighten the mounting screw to firmly secure the cutter in place. 

- Is the blade of the cutter worn? 

If the tip of the cutter is worn, replace the tool with a new one. 

Q11:	What	is	the	black	soot	attached	to	the	spindle	motor?	

A: The spindle motor has a motor brush inside and the brush is abraded away after a substantial operating time. 

The abraded portion makes up the soot and is ejected through the hole of the motor. It has no problem in 

practical use. 

Q12:	The	taper	of	the	cutter	contacts	vertical	wall	of	the	workpiece	
and	interferes	with	cutting.	How	can	I	deal	with	it?	

A: The genuine cutter makes a sudden stop due to an impact induced when it touches the vertical wall of the 

workpiece with a height of 6 mm or more. 

The wall height should not exceed the effective cutting length of the cutter. 

Q13:	How	can	I	remove	the	cutter	from	the	collet?	

A: First remove the set screw secured at the collet and withdraw the cutter using pliers. 

Please wear gloves before removing the cutter and be very careful not to get injured. 
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Q14:	What	should	I	do	when	the	cutter	falls	off	the	collet?	

A: The set screw may be too loose to secure the cutter within the collet. 

Please use the attached hex wrench to tighten the set screw. 
 


